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This workbook is intended to get users started; detailed reference information is found in the 
Online Help and Training Videos. This is accessed from top screen menu bar Help option or 
clicking on the Help button. [Pressing F1 key from most screens too] 
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Assisted Program Basics  
This self-paced tutorial assumes that you have the Manager SE v.9.1.x installed on your PC. If 
you do not have the software installed, the most current released version is available for 
download at: https://kb.mitchell1.com/manager-files/. [SE update is always line item #1] 

Once the SE software has been installed, change it to DEMO mode using the instructions on the 
next page. (Then you’ll have samples to work with) 

IMPORTANT: Always use this book with the DEMO version. It will be easier to understand the 
concepts working with sample customers, vehicles, parts, orders and jobs. Be sure to switch back 
to LIVE mode once you start entering data you wish to keep. Data added in DEMO mode cannot 
be transferred into the LIVE version later. 

Work these exercises in order as one section of the tutorial builds upon previous entries. Use of a 
printer is optional, although recommended, if one is available. 

 Switching SE live program to DEMO mode  
1. From “home” (splash) screen, click on Configurations, Special Maintenance.  

 

https://kb.mitchell1.com/manager-files/
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2. Select Toggle Demo Mode; program will prompt you to restart.  

 Once restarted, an on-screen text box indicates “Training Demonstration” (DEMO) mode. 

Note: Look for the Training Demonstration Overlay to ensure you are working in Demo mode. 
This will allow you to access the pre-built demo database examples of Parts, Canned Jobs, etc. 

Entering Customer & Vehicle Information 
Create a new customer / vehicle record as follows.  

1. From upper text menu, click on Utilities (Alt + U) then select 
Customer Screen option. 

 
 

2. Type the customer’s information into your Customer screen: (entering Zip Code then pressing the 
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Tab key* automatically fills City + State fields) 

• John Jones 

• Kathy (Spouse) 

• 1544 Kingsland Way 

• 92064 (zip + Tab) 

• Zip, City, State enter automatically 

• 888-724-6742 

• jsjones@cox.net  

3. With customer data entry finished, click the Vehicle Tab ( or Alt + V). 

Vehicle screen displays for vehicle entry. Type in the license plate and select Year / Make / 
Model, Body Style & Engine/Fuel vehicle data from the drop-down menus to match the 
values in the screen below. 

 

Note: DEMO has no VIN Decode or Plate Lookup functions; enter license # + year-make-model. 

4. Then click on the Exit Button (Alt + X) to finish entry and close Vehicle screen. 

Note: Use ‘drop-down menus’ when entering vehicles to ensure Estimator access to OE parts, 
labor, maintenance or TSBs. Manually type in Y-M-M only when vehicle is pre- 1974 or if it is a type 
of vehicle not covered in Estimator. 

5. You are prompted to save your changes. Click Yes  to confirm this vehicle and customer 
information is being added to the SE database for future use. 
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Click the W.I.P. button to display the Work In Progress screen. Think of W.I.P. as the rack 
that held hand orders. WIP screen provides an overview of all current business in your 
shop. We will provide more details on this screen later. 

 

 
This concludes the basic customer / vehicle entry exercise. Continue on to Creating an Estimate 
with this data entered. 
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Creating an Estimate  
Creating an Estimate for customer ‘John Jones’ (2013 Chevrolet Impala) 

1. Click on ‘New’ (press F6 key) to begin writing this Estimate. 

 

Note: ‘New’/F6 key “remembers” last setting. Be sure 
Estimate is selected, NOT Repair Order. 

Customer List for Start Order window quickly verifies a customer exists in database. If not 
found, New Customer button would be used to start entry. 
In the Last field, type ‘J-o-n’. 

 

2. When ‘Jones, John’ appears in results, double-click on it (or press Enter) to select Jones and start an 
estimate. 

Customer information is retrieved and Customer screen displays automatically. The customer we 
entered (John Jones) has only one vehicle so it is automatically selected.Click on (Alt + O) to 
advance to the Order screen. 
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3. The Order Screen displays. Enter Vehicle Mileage as 45657 

Note: Enter mileage; program warns later if it’s missing. It is crucial for 
your customer communications and SocialCRM reminders to have 
accurate mileage.  

  
Begin adding order items to the Estimate, starting with a Symptom. 

NOTE: If Symptoms is not set to pop-up automatically, click button as shown. 

A Symptom is a vehicle complaint that the customer is requesting your shop to look into. These 
include description, category and labor time to diagnose it. Additional text can be entered; this 
input helps the tech figure out the cause. 

4. Click on Symptom (Alt + Y) to add the customer’s vehicle complaint. 

The Symptoms Reported by Customer screen displays a listing of symptoms to select 
from. 

5. Choose the first Symptom, AC Won’t Cool and click Select Symptom. The symptom details 
display in the right screen panel. You may change any of the values in this screen as desired. 
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6. Click on the Done Button (Alt + D) to copy the Symptom into the estimate. 

Note: Symptoms use stored descriptions with labor times & prices. This makes it faster to receive 
vehicles and process customers; captures diagnostic time that should always be billed out. See tip 
below to set automatic list pop-up. 

The Order Screen displays the Estimate with transferred Symptom as a labor item. 

 
7. Click on the Jobs button (Alt + J) to open Canned Job list.  
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The Canned Job List opens. 

8. In Description, enter ‘rec’ as partial search phrase. (not req’d to type entire job name) 

9. Click on the Search button (or press Enter) to find jobs that include ‘rec’ in 
Description. 

10. Check the box in the Tag column for ‘A/C Rech1’; then click the transfer button to add the Canned 
Job (Freon + labor) to this Estimate. 

 
The Canned Job repair lines display in the Estimate. 
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The Completed Estimate  
This basic Estimate (Symptom - diagnostic time + ‘A/C Recharge’ Job) is now ready to print. 
(TIP: checking profit before quoting it is on the following page) 

11. Choose Preview from the File menu to preview this Estimate on your screen. 

 
The Print Preview displays how printed estimate appears. 
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The Parameters box in the left sidebar allows you to change some of the settings in the print 
preview.  

12. Change the Include Header setting to NO and the Show Part Numbers setting to Yes and 
press the Submit button.  

  

You will see that the Header has been removed from the top of the Estimate and the Part 
Number (FREON) has been added. 
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13. (Optional) Click the Print button to print the estimate. 

14. Closing the Print Preview X returns you to the estimate on Order screen. 

NEXT: F12 key = Check Profit 

Using the Profit Wizard  
Profit Wizard provides a pie chart overview of costs / profit for this entire order OR [NEW] at the 
job level by selecting a specific job from the drop-down list. Use the F12 function key as a 
shortcut to open this or by selecting Options > Profit Wizard. 

Note: To get accurate numbers, use the Profit Wizard after actual labor & parts costs have been 
entered. ‘Please, Select’ labor tech entry provide a sample labor cost. 

  
Miscellaneous & Overhead are entered in Setup and don’t impact INV totals; makes pie chart 
more realistic beyond part costs & tech pay. 

NEXT: With profit verified and customer approval, convert Estimate to R.O. 

 Converting an Estimate into a Repair Order  
Typically, an estimate is prepared to get customer approval for the work. Once the customer 
agrees, that estimate is typically printed, signed, then converted to an active R.O. [your state 
regulations may vary on this] 

1. Click on Convert to Order (Alt + O) in the lower left corner of the Order screen. 

The System will then ask for confirmation to convert this Estimate to a Repair Order. 
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2. Click on Yes (type ‘Y’ or press Enter). Order Screen now displays as Repair Order#(with 

permanent # assigned). 

Note: Shops create many Estimates; some don’t result in actual work. These get temporary 
“throwaway” numbers. When an EST is converted to an R.O., it’s assigned a new permanent 
number kept through the INV stage into History. 

 

 Assigning Techs to R.O. / Print Tech Worksheet  
Now that we have an active Repair Order, we need to assign technicians. Drop-
downs are available in the Work in Progress grid to allow you to quickly assign a 
technician to each Part or Labor item. The drop-down technician list is enabled by 
right-clicking on the Tech Grid entry shown to the right (displays as None 
initially). 

To Assign the Technician to a repair line: 

1. Right-click on the first Tech grid (highlighted). 

2. Choose Charbonneau, Wayne from the Dropdown. 

3. Repeat for the next three Repair Lines. 

 

Note: You can also assign the technician by choosing Options and selecting the Default Labor and 
Parts technician for the Order. This is generally the quicker approach for orders with a lot of line 
items assigned to the same technician. 
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Once you have set the Technicians, the Repair Order is now ready to print. 

4. Choose File/Preview to preview the Repair Order on-screen. 

You may get a validation warning. 

 
5. Depending on system settings, there may be validations; just click on Continue Print (or press 

Enter) and continue to the print preview for the purposes of this exercise. 

Inspect the Repair Order content in the Print Preview window. 

  

Note: You may also increase/decrease (zoom) the preview size by changing selected in the top line 
icons as shown 

6. Click on the X in upper RH corner of screen (Alt + F4) to close 
the Preview. 

7. Next you will be prompted to mark this Repair Order as Printed. 

Click on Yes to mark this Repair Order as printed. 
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Note: Marking the Repair Order as ‘printed’ triggers two important things: 

• Sets ‘Time/Date In’ field (visible in WIP Detail) as start of actual work. 

• Parts become ‘Committed’ and visible to Pick List / Purchase Order process. You don’t 
have to actually print to paper; automated setting TIP shown below. 

Tip: It is also possible to automatically Mark All ROs As Approved/Printed in the Screen View 
settings under Configuration > Shop Data. This time-saving setting bypasses the RO “printing” 
steps as shown previously. 

During the Convert Estimate to R.O. sequence, you’ll be prompted for printing a Technician Worksheet.   

8. Choose Yes to preview the Technician Worksheet. This worksheet includes details on services to 
be performed and space to record inspection findings. 

Note: You cannot print the worksheet in SE Demo Mode, ordinarily you would print a copy for the 
Technician 
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You can close the window by clicking the X in the right corner of the screen. 

Note: Invoices use the same # assigned during R.O. An INV can be changed back to an R.O. if last 
minute items are added.(Configurations > Shop Data > Default Settings tab option) 

NEXT: Converting a Repair Order to an Invoice  

Converting the Repair Order to an Invoice  
Once the repair has been completed, you will need to convert the Repair Order to an Invoice. 

1. Click on Convert to Invoice (Alt + O) (lower LH corner of Order screen). You are asked to 
confirm your request. 

 
2. Click on Yes (press ‘Y’ or Enter) to confirm conversion from R.O to an Invoice. Program 

confirms parts previously committed to the order were installed and subtracts them from 
inventory where applicable. 

The Invoice screen looks exactly like the R.O. screen; the only difference is that it now 
displays as Invoice #. 

 
Before we advance to Pay & Post phase, try two WIP Options with this Invoice. 

3. Click on Exit  (or press Esc) to return to the Work-In-Progress screen. 
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 Work in Progress Screen  
The ‘WIP’ screen provides access to all your current shop estimates, 
repair orders, and invoices. The grid area of the screen contains 
pertinent information about the order and is configurable to suit your 
shop’s needs. This is the screen that should be open when you are 
not working directly with a specific order. 

TIP: Use the Up/Down arrow keys and press ENTER as a shortcut to select any EST/RO/INV/SO 
item to open up on Order screen. When finished, press ESC key to return to the WIP screen. 

 

 
The WIP screen provides various tools for working with and making adjustments to orders; watch 
videos to learn more. Two of these options are discussed below: 

1. Click on Appointment to view scheduling details for this order in the Appointment Editor. 
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Look over the various options available for scheduling then click Save and Close or X to close 
the scheduler. Visit https://kb.mitchell1.com/articles/id-803/ for detailed information on working 
in the scheduler. 

WIP Detail includes several fields to update.  

2. Click Detail (or right-click mouse on that order). With Jones, John already highlighted, 
update the status of details. 

 
3. Click Detail to display details of Invoice. (Jones, John) 

Update these WIP Detail fields: 

• Status: Completed 
• Location: Front Lot 

https://kb.mitchell1.com/articles/id-803/
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4. Click on OK to save. 

The WIP screen is visible again with Invoice (Jones) highlighted. 

5. Double-click (Alt + O) to open the Jones Invoice again. 

NEXT: Apply Payments & Post the Invoice 
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Apply Payments & Post the Invoice 
John Jones is here to pick up the vehicle and you will now complete the order cycle by collecting 
payment, printing a finished invoice and posting it to History. 

  
To Pay/Post Invoice: 

1. Click on Pay/Post Invoice (Alt + O) at the bottom left corner of your screen to open the Apply 
Payment window. The Invoice Total is automatically entered for you as the Payment. 

2. Enter Payment Type: ‘V’ selects 
(Visa) + Authorization #: 558163 

3. Click the Pay button. 

Note: Default payment type is selected in Shop Data Setup. Payment Amount = defaults to INV 
balance due. Print Receipt is optional 

4. When the Post Invoice dialog box displays, click on Yes (‘Y’ or Enter) to 
continue. 

TIP: When work is completed but customer is not there to pick up the 
vehicle, post the invoice as Charge to keep the invoice off of your WIP 
screen. Then use Batch Payment (F5) when they arrive to pay the Invoice. 

The system will automatically display the Posting Date dialog window below. 
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5. Click to place a check in the Print Invoice before Posting checkbox. This box only needs to be 

checked once; the system will remember this preference. 

6. Click on  to continue the process of Printing and Posting. 

7. Depending on system settings, there may be further Validations; just click on 

 (or press Enter) for this exercise and continue to the print preview. 

Note: Once comfortable with the program, you may go to Configurations – Reports/Printers area 
and turn off Default Print to Screen option to skip preview steps in the future. 

Print displays what your final printed invoice would look like. 

 
8. Click the X to close the print window. The Invoice is closed into Order History and you are 

returned to the WIP screen. 

How to find the John Jones Invoice in the History file: 

9. Go to Utilities menu, select Find History Record (press F4 key).  
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10. Double-click on the John Jones invoice to open history for the customer. This allows access to view 

Details, Print or Un-Post an Invoice. 

 
11. Click Details to view the Details of the Posted Invoice in History 
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 Entering Recommendations  
The Recommendations field is provided to enter service or repair needs 
identified for customer’s vehicle. These findings are typically written on Tech 
Worksheets and returned to the Service Writer for entry. This information will 
be displayed within the Vehicle Screen as a reminder of noted repair needs, not 
performed as yet. 

NOTE: Revisions for storing actual work details will be discussed after this. 

1. Click on the New button (F6) type jo in the Last (name) field and select Jones, John (any name 
will do) 

2. Go to Vehicle (Alt + V) screen. 

 
3. Click on Add in the Recommendations section to begin entry of your first Recommendation. 

• Today’s date (default) is fine; use drop-down calendars or type dates if desired. 

TIP: Date Work Needed is usually same as Date Recommended; it is provided to input 
repair needs to be completed by future date (30 days later, etc) 

• Category: Select ‘Automatic Trans/Transaxle’ (or press ‘A’ 3 times). 

• Type: ‘Test drive: shifting not smooth; perform trans service 1st.’ 
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4. Click OK in Recommendations to save your first entry and proceed to begin entry of the second 

recommendation. 

Note: By creating separate Recommendations for each identified repair issue, your follow-up 
marketing can be more precisely focused and you streamline the process of adding individual 
repairs when the customer only wants part of the recommended work completed. The requirement 
to include a Category as a filter is part of this approach. 

5. Click on Add button (Alt + A) again to enter a second Recommendation. 

6. Press the Tab key to move down to the Category field. Scroll down the Category list and 
select Brakes. 

Type: ‘Test drive: poor hard braking; perform ABS Brake inspection’. 

 

7. Click on  to save this Recommendation; the two entries display. 
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Tip: Saving Recommendations as Standard Notes saves time. To create and store repeatable 
Recommendations text, go to Setup – Standard Descriptions - Notes tab. It will still be necessary 
to select Category when applied to vehicle. 

All recommendations will be listed within the Vehicle screen as shown above. When tab is green, 
it indicates Recommendation(s) are on file for this vehicle. 

 

Note: The Vehicle tab will not turn green until you actually leave the Vehicle screen. 

On future service visits for this vehicle, this visual reminder will also appear when a new order is 
started: 

Entering Revisions  
While a test drive triggered Recommendations to describe problems seen, 
it’s time to work up actual repair costs. Revision has 9 separate Sub-
Estimates tabs for transfer to Order, pending customer approval. 
Thisprovides an ability to perform "what-if" pricing options of original 
repairs along with various Sub-Estimate (repair job) combinations. 

Revisions can contain all parts and labor detail for additional work discovered. These can be 
transferred to an existing estimate or order, once your customer approves them. Sub-Estimates 
not approved and sold today will remain on file (with reminders) on future repair visits. 

Note: Sub-Estimates contain any combination of Parts, Labor, Sublet, Notes, Canned Jobs, Part 
Kits). Separate Sub-Estimates allow users to arrange these by job; these are stored and then 
transferred to orders in any combination. 

1. Go to Revision screen (Alt + R) to create a Sub-Estimate. 

2. From Revision screen, click Jobs (Alt +J) to open the Canned Job list. 

Transferring a Canned Job into a (Revision) Sub-Est1 workspace: 

3. Enter ‘trans’ in the Job # field. 

4. Click on Search (or press Enter). SE Search finds a matching entry. 

https://youtu.be/5bPJ1vT_i44
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5. Tag the TRANS job and click on  (Alt + T) to copy into Revision (Sub-Estimate 1). 

The Revision screen now displays SubEst1 with the TRANS Canned Job added. 
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6. Click on  tab to open the SubEst2 Revision workspace. 

7. Right-click on the .00 line in SubEst2 grid to open the Quick Canned Job list. 

 
8. Click on BRK Inspect (STD), Brake Inspection (non-ABS) from the list.  

Revision screen now displays SubEst2 with the BRAKES Canned Job added. 
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Rename each Sub Estimate tab to identify work 
 

1. Double-click directly on SubEst1 tab text; type Trans Service, then click once anywhere to save 
this change. Repeat this process for SubEst2 tab and enter Brakes. 

The Revision tabs display with the updated SubEst text specific to the work: 

 

You now have a Revision screen with two sub-estimates ready to transfer to the order once 
approved. 

 Sell (Transfer) Revisions  
The Revision Authorization screen is useful to provide customer with options, 
get their approval, then transfer these Sub-Estimate(s) to the active Order 
screen. 

1. Click on Sell Revision to display the Revision Authorization screen. 

2. Select / input the following: 

• Initiated by: Shop 

• Written by: McDonnell, Tim 

• Authorized by: Jones, John 

• Reason: Wants problems fixed 

• Method: Customer Called In 

• Include in this Revision: Select both Trans Service and Brakes.  

Checking/un-checking these Sub-Estimates boxes is how to review repair pricing options with the 
customer. If customer can’t handle all repairs today, un-check a Sub-Estimate and quote a revised figure. 
Un-sold Sub- Estimate(s) remain on file for future service visits with pop-up reminders. 

https://youtu.be/Fygf-T-lW8E
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NOTE: It is recommended that ‘Clear Sub Estimates after Transfer’ remain checked to avoid later 
introducing work that has already been performed. 

3. Once the Revisions are agreed upon, click Transfer to trigger the process to move selected 
Revisions onto the Order screen. 

The Recommendations screen automatically prompts user to review and clear any related 
Recommendations, IF any of these triggered the creation of specific Revisions to address. 

 

Note: Look at Recommendations very carefully. Delete only those taken care of by these 
transferred Revisions. Follow-up on Recommendations is a valuable tool driven by these entries; 
take care not to lose any new sales opportunities. 

4. Delete the two Recommendations and click OK. The order now displays the line items for the two 
revisions. 
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End of the Assisted Program Basics section 

This concludes the assisted portion of management training.  

Users should continue with the Self-Instruction portion of the book to learn more about the 
software and about additional help and video training options available to help you become a 
Shop Management software power user.. 
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 Self-Instruction  
The Assisted Training portion of this workbook gave you the basics on the program workflow 
from Estimate through Invoice as well as the process of creating and adding vehicle-specific 
recommendations to an order. The Self-Instruction sections of this workbook delve a little 
deeper into important subjects like adding parts to the Inventory List, Creating Canned Jobs, and 
Scheduling.  

Help/Training Video Resources 
Before launching into the self-instruction portion of this guide, please take a moment to 
familiarize yourself with the help/and Training Video resources that are readily available to you 
within your management system.  

• The How do I link under Training Videos 
provides access to more than 100 training 
videos covering every important program 
function. 

• The Help menu provides access to the Help 
Files Index (Home Page) and 
Documentation (Document Central) which 
includes the most current versions of the 
program workbooks and other  guides for 
working in the shop management system. 

• Finally, context-sensitive (F1) help is available within almost any of the management 
system screens and dialog boxes. What this means is that you can access help that is 
specific to what you are working on simply by pressing the F1 key. Also, if there is a 
training video available for the screen you are in, a link to it will be provided at the top of 
your help screen.  

 
Now that you have reviewed the basic online help options, we’ll continue with the Self-Instruction 
tutorial exercises. 

https://managerhelp.buymitchell1.net/Howdoi.htm
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Adding a Part to Inventory  
The Inventory List screen has two primary functions:  

• Searching existing Part records 

• Entering new Part Records 

The SE Search function is used to find existing parts and add them to an Order or Revision; it also 
serves as an input screen to add new part records that can be applied to orders repeatedly. 

1. Click on the Inventory icon. 

2. Click on Add (Alt + A) to begin the new part entry process. 

• Part No.: 70-5YR 
• Part Code: bat [auto-fills Description + Category]  
• Re-Order Point: 1  
• Stocking Level: 3 
• On Hand: 2 
• Last Cost $: $43.60 (Note: when your Price/Markup Matrix has been completed in Setup, 

the Price will calculate automatically.) 

 

3. Click on Vendor; select Interstate Battery (BATT) from list and click OK. 

http://youtu.be/HrjHEqXLz34
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4. Click OK in the Add New Part dialog box. You are prompted to confirm the new Part. 

 
5. Click Yes to complete the part entry process. The Inventory List screen displays the new part 

record. 

 

6. Click Done to close Inventory List screen. 
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 Creating a Part Kit  
Part Kits save time by grouping any number of 
items that are frequently sold together. 
(Examples: tune-up parts, lift kits, etc). 

This exercise will create a ‘Radiator Hose’ Part Kit from part records 
existing in the Inventory List. 

1. From top menu, click on Utilities, Part Kits. This is whre you go to add, 
edit, or delete a Part Kit. In this Exercise we will be adding a new Part Kit. 

 

2. Click on Add (Alt + A) to open the Add Kit screen. 

3. Enter/choose the identifying Kit information. 

• Kit No.: 7202-Kit 
• Description: Radiator Hose Kit 
• Category: Belts & Hoses (type ‘B’ twice) 

 

https://youtu.be/ClWPyKkZARE
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Now that you have named the kit, you will want to add some parts to it. 

4. Click on Add (Alt + A) to open Inventory to add part to a new part kit. 

 Enter the following: Part No.: 7202 

5. Click on Search (or press Enter). 

6. Click on Transfer (Alt + T) to place a copy in the Part Kit. 

 

Note: The Program also automatically transferred two hose clamps that had been “attached” to the 
radiator hose part record.  

7. Click on Add (Alt + A) to open Inventory to transfer a 2nd part into kit.Click on ‘Clear’ to add 
a part from a different category.  

8. With Category cleared, enter ‘anti’ in Description. 

9. Click on Search (press Enter); ‘afc1/2 Anti-Freeze Coolant ½ Gal’ is located automatically. 

 
10. Click on Transfer (Alt + T) to copy ‘afc1/2’ part record into the part kit. Add Kit displays with 
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transferred radiator hose, hose clamps and Anti-Freeze. 

A simple adjustment is required; change quantity of anti-freeze to 2 units. 

11. Double-click on the Anti-Freeze line (or click Edit). The Edit Kit Line dialog box opens.  

12. Change the Quantity to 2 (2.00) and click OK . 

 
The Add Kit window displays with the adjusted Anti-Freeze quantity 

 
13. Click OK in the Add Kit window to save your input work. 

14. Click on Done (Alt + D) in Part Kits window to close. 

The 7202 Kit is now included in the Part Kit list and ready to use. 

TIP: Part Kits can also be used to manage part options when attached to Canned Jobs. 
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Creating a Canned Job  
Canned jobs save time entering work onto orders by grouping 
parts and labor that are used in repeated combinations. In 
this exercise, we’ll build a canned job to perform a Cooling 
System Flush & Pressure check. 

1. Using the menu bar at top of screen, click on Utilities, Canned Jobs. 

2. From the Canned Job List screen, click Add (Alt + A) to open the Canned 
Jobs creation screen. From the Canned Job List screen, enter the following: 

• Job #: Flush-1 
• Description: Cooling System Flush & Check 
• Category: Maintenance 

3. Click Labor (Alt + L) to add labor content to the Canned Job. 

4. In Order item entry – LABOR screen enter the following: 

• Work Requested: Flush Cooling System, Install New Anti-Freeze, Pressure Check. 
• Work Performed: Drain & flush radiator, inspect hoses & clamps. Add cooling 

system lubricant. Add up to 1 gallon of coolant. Check thermostat and electric 
cooling fan operation. 

• Charged Hrs.: 1.2 
• Category: AC/Heating/Cooling 
• Account: Labor Revenue 

Click on Save (Alt + V). 

 
This copies Labor item to Canned Job, keeping entry box open for next entry. 

 

 

https://youtu.be/NhJP-08ffpU
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Now begin adding Part items to the Canned Job. 

1. After saving the Labor item, click on the Parts tab to begin adding parts. 

2. In the Order item entry – PARTS screen enter the following information: 

• Part No.: afc1/2  

• Quantity: 2 

 
3. Click Save (Alt + V). This keeps the entry box open for the next part selection or entry. 

4. Enter the following: Part No.: bar1 

5. Press Tab key and part details fill in automatically. (Quantity: 1 is fine) 

6. Click on Done (Alt + D) to save the part and close entry screen. 

The completed Canned Job displays. 

Note: We recommend that Year-Make-Model be left ‘All/All/All’ so that the Canned Job Search 
would always find it, no matter which vehicle is selected. 
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Click on Exit (Alt + X) to close the Canned Job list window and return to the screen you were working on. 

TIP: Parts & labor items may also be copied and pasted into Canned Jobs from an existing Order or 
Revisions sub-estimate. 
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 Writing a Counter Sale   
Counter Sale provides a fast method to sell parts to walk-in 
customers. This exercise will show you how to write a basic Counter 
Sale and (optional) how to add an existing Customer name to the 
transaction. 

1. Click on Counter (or press F11 key) to begin. 

2. Click on Parts (Alt +P). 

3. Type “wb1”. A popup listing of all parts beginning with WB1 is displayed. Choose WB14 from the 
list. (Part record details fill in) 

4. Change Quantity: 2 and press tab. 

 
5. Click on Done (Alt + D) to save part to the sale & close the entry screen. With the part 

added to this Counter Sale, you could collect payment from this “Cash” customer, print an 
invoice and be done. 

Next we’re going to show how to add an existing customer’s information; this is useful for 
tracking items with warranties, such as batteries. 

6. Click on the Customer tab to access list of existing customers. 

The Customer screen displays for this Counter Sale (no name included yet). 

https://youtu.be/j9tGXuLef90
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7. Click on Name (Alt + A) to open the list of existing customers. 

 
 

 

8. Select a name from the customer list and then click OK or just double- click directly on the name 
itself, as this will also select it. You are returned to the customer screen with the Customers name 
and info and his Vehicles displayed. 

Note: You could also click New to add a new customer if a name is not found. 

9. Click on Order (Alt + O) to Pay, Print & Post this Counter Sale. 

10. Click on Payment to process the customer payment. In Payment Type, type a ‘C’ (shortcut for 
Cash payment type or select Cash from the menu. 
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11. Click on Pay to record the payment. 

12. Answer affirmatively to the next three questions (Yes, Yes, OK):  

Make certain there is a check mark in “Print Invoice before Posting?” box. (this only has 
to be done once; users can print invoices reflecting payment info) 

 
The Counter Sale displays in Print Preview [next page] 
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13. Click on X in upper RH corner of screen (Alt + F4) to close Preview. You are asked to confirm the 

order as printed (and therefore complete). 

 
14. Click on Yes (‘Y’ or Enter) to mark Counter Sale as printed. 

The Counter Sale is removed from WIP & posted to History. 
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 Create an Appointment  
Scheduler events (appointments) are created when you start an 
Estimate or Repair Order. The exercise below demonstrates how you 
can create an appointment for a customer in advance of their visit to 
the shop. The subsequent appointment can be converted to EST / RO 

from the Appointment Editor screen. 

1. Click the Schedule button to open the Scheduler. 

 
2. Scroll to Tomorrow’s date and double-click on it. The Find Customer for Schedule dialog box 

displays. 

4. Click on New Customer to open the Create New Customer dialog box. 

5. Type the Last and First Names (Wilson, Jim) and an Address (123 Elm St.).  

6. Enter the Zip Code and press TAB.  

7. The City and State are entered automatically for you. Enter 512-333-4444 as the phone number. 

8. Click OK. 

https://youtu.be/erkDajnCoWk
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The Vehicle Selection dialog box opens. Because it is a new customer, there are no Vehicles displayed. 

9. Click on Add Vehicle. 

The New Vehicle dialog box displays. 

Note: VIN Decode and License lookup are not available in Demo mode, so you must manually 
enter your vehicle. 

10. Fill in the vehicle fields: 

• License: FJB 3831 

• State: TX 

• Vehicle: 2012 Toyota Tundra Limited 

• Body Style: 4D Pickup Extra Cab 

• Engine: 5.7 L V8 

• Trans: 6 Speed Automatic AB60E 
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11. Click Save & Close. 

The Appointment Editor dialog box displays. Tomorrow’s date and the drop-off time of 10 
am is automatically scheduled. 

12. Change the End Time to 1:00 PM. 

 
13. Click Add in the Jobs section to add a Canned Job to the scheduled appointment. The Canned Job 

List displays. 
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14. Choose LOF as your Category and click the Search button. Matching jobs displays in the lower 

grid area. 

15. Choose LOF EZ Select 5. 

16. Click Transfer. The Canned Job is added to the Appointment detail.   

17. Add a note Customer’s son to pick up vehicle to the Shop Comment section. 

 
18. Click Save and Close. 
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The Appointment now appears in the Scheduler under tomorrow’s date. 

 
 

It is highly recommended that you watch the detailed videos in the SE online 
help system. Simply click Help [F1 key] in any Scheduler screen to access the 
videos. Click the icon to the right to view the demo Appointment Scheduling 
video. 

https://managerhelp.buymitchell1.net/Howdoi.htm
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 Invoice History  
Users can search for a specific invoice number or for history records on certain vehicles and/or 
repair work in history. 

1. Click F4 or choose Find History Record from the Utilities menu. 

The Find History Record screen displays in Invoice view. 

 
2. Double click on James, Jesse; displays history records for his selected vehicle. 

 
 

3. Click Show Categories to show all Categories included on each invoice. 
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Vehicle View 
1. Click F4 to open the Find History Record dialog box. 

2. Find past work in history by any combination of Year-Make-Model and/or Word Search. 
[enter a make without years or models if you like] 

3. Select the Vehicle tab. 

4. Set up your Search Criteria. In this instance, do a Word Search for ‘A/C’ for ‘Toyota’with a 
Posted Date of 1/1/2005-12/31/2005. 

5. Click the Search button. Your results display in the grid below. 

 

6. Press the Esc key to close the Find History Record screen and return to the History screen. 

Other History screen options 

• Unpost Invoice - Allows un-posting an invoice for corrections. (Do NOT answer Yes to ‘use 
Current Rates’; may affect existing totals when reposted.) 

• Search - Filters History invoices list based upon key word(s) entered. Searches parts and 
labor descriptions of each invoice to find matches and narrow the list. 

• Detail - View selected invoice parts and labor detail with history of payments. History 
Detail window allows viewing individual order lines. 

This concludes the self-instruction portion of workbook exercises. On the following pages you will 
see how to visit managerforum.net and also where to access the SE Training Video 
Modules/Quizzes certificate program. 
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 Managerforum.net Discussion Board  
Answers, Tips and Ideas 24/7, Visit Managerforum.net and join us now! 

Q. What is a forum account? 

A. It’s used to identify members (security); it’s how the forum can know what you’ve already 
seen, what’s new and which email address to use for your notifications. 

Q. How do I get started? 

A. Click on the Forum icon and start browsing. To post questions and replies you need to do a 
one-time registration using the Register link on the site as shown below: 

 

Q. What happens after I click Register? 

A. You are sent an automated email with a link to “complete the circuit”. Once you click that link, 
you may log into the forum. 

NOTE: If you do not see the activation email within a few minutes, please check your spam folder. 
If not found, click on Forum Administrator link found at the bottom of every forum page. 

Q. What do users say about using the Forum? 

A. “A meeting place where you can interact with others like yourself, get answers to questions 
and tips on how to use Manager to its fullest. It’s one of the best tools in your toolbox.” 

“One thing I love about this forum is all the great input we get from shops like us. I wish I 
would’ve started on here sooner” The insights and fellowship provided is unbelievable!” 

 

  
  

https://www.managerforum.net/
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Shop Management Modules & Quizzes  
To develop a more thorough understanding of SE software concepts, we recommend taking 
advantage of our 4 modules/quizzes certificate program accessed as follows: 

• Manager SE: http://m1training.net  

• ShopKey SE: http://sktraining.net  

and click on the Manager SE or Shop Management SE link. 

 

We highly recommend  you complete all of the video modules and pass the quizzes. A certificate is 
available for each quiz passed with 85% or higher grade 

 

 

http://m1training.net/
http://sktraining.net/
https://mitchell1.com/support/manager-se/
https://www.sktraining.net/shopmanagement/
https://mitchell1.com/support/manager-se/
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